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THANK YOU FOR CHOOSING ROSS VIDEO
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)

About this Guide
• Ross Part Number: 7800DR-016-03

• Release Date: June 27, 2025. Printed in Canada.

• Software Issue: 10.3.0

The information contained in this Guide is subject to change without notice or obligation.
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© 2014 - 2025 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross 
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and 
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior 
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross 
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting 
from the use of the information contained herein.

Patents
Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 
7,914,332; 8307284, 2039277; 1237518; 1127289 and other patents pending.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its Streamline Xchange Server systems to be free from defects under normal 
use and service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Streamline 
Xchange Server system, contact your regional sales manager.



Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration. You can also contact Ross Video for more information on the environmental performances of 
our products.

Use of Hazardous Substances in Electrical and Electronic 
Products (China RoHS)
Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html


Company Address

Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613.652.4886

Fax: (+1) 613.652.4425

Technical Support: (+1) 613.652.4886

After Hours Emergency: (+1) 613.349.0006

Email (Technical Support): techsupport@rossvideo.com

Email (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction

A Word of Thanks

Thank you for choosing Streamline Xchange as your Ross Video media asset management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Xchange media asset management solution from Ross Video. 
We are confident of your future pleasure with your choice.

Yours Sincerely,

Peter Abecassis
Director, Product Management – Media Asset Management (MAM) & Storage
peter.abecassis@rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide

This guide contains the following chapters that cover the installation and configuration of Streamline Xchange 
software:

• Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature 
descriptions.

• Chapter 2, “Installing Streamline Xchange” describes the process of installing Streamline Xchange for the first 
time and preparing the software for its initial setup.

• Chapter 3, “Installing Streamline Xchange with a Render Node” describes the process of installing Streamline 
Xchange with a Node, and allowing a Node server access to the Xchange database.

• Chapter 4, “Attaching Streamline Xchange to Workflow Server” provides instructions on how to access the 
Xchange database, set up containers, and register media from Workflow Server to Streamline Xchange through 
scripting.

• Chapter 5, “Adding a New Render Profile with the Workflow Server Container” provides instructions for 
adding a new Render Profile.

• Chapter 6, “Setting up Xchange Proxies for Playback in the Workflow Suite” provides instructions on how to 
set up Xchange Proxies.

• Chapter 7, “Configuration of Users” provides instructions on how to access the Configs module and how to set 
up, edit, or delete Users.

• Chapter 8, “Configuration of Groups” provides information about accessing, setting up, editing, or deleting 
Groups, as well as the functionalities of Groups.

• Chapter 9, “Installing the Streamline Xchange Adobe Panel - Windows” provides instructions on how to 
install the Streamline Xchange Adobe panel for Windows.

• Chapter 10, “Installing the Streamline Xchange Adobe Panel - MacOS” provides instructions on how to 
install the Streamline Xchange Adobe panel for MacOS.

• Chapter 11, “Configuring Microsoft AI” provides instructions on how to configure Microsoft AI to detect 
languages.

If you have questions pertaining to the operation of any Ross Video product, please contact us at the numbers listed 
in the section “Contacting Technical Support” on page 1–4. Our technical staff is always available for 
consultation, training, or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Streamline Xchange User Guide.
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Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

 NOTE: When the Streamline Xchange Client cannot connect to the network, a Message dialog box opens to 
report the connection problem.
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Getting Help

The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the 
product.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents

• Index — keyword reference

• Search — full text search

• Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 833-859-0499

Direct to tech support: +833-859-0499

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online

E-mail: techsupport@rossvideo.com 

Website: open a support request using the following link: http://www.rossvideo.com/support/tech-support.html

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com/support/tech-support.html
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Installing Streamline Xchange
The Streamline Xchange Suite is a Web-based platform to store, share, edit, review, approve, archive, and prepare 
your footage from anywhere. This metadata-driven application features a comment, rating and media activity 
tracking system for finding the assets you need, when you need them. Additional functionality includes the ability 
to create markers and subclips with embedded metadata for use later in the production.

This chapter discusses the following topic:

• Installing Streamline Xchange for the first time
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Installing Streamline Xchange for the first time

To install Streamline Xchange

1. To extract the Streamline Xchange installer, right-click the provided 
xchange-10.2.1-2025.05.01-09.40-68ec7ebb.zip file and click Extract All. Select a preferred location for the 
folder and click Extract.

2. Open the XchangeInstaller folder, then double-click XchangeInstaller2.0.exe to launch the application.

3. When the Streamline Xchange Installer window opens, enter the following login credentials:
Username: admin
Password: xxxxx

 NOTE: Please reach out to Ross Video Technical Support for information regarding the password, if it has not 
already been provided.

4. Click Submit.
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5. Under Installation Type, select Install and then click Next.

6. Click the Check buttons in the order shown in the image below; Ports Check, then Visual C++ Check from 
left to right:
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7. After clicking one of the Check buttons, a message will appear to confirm the availability of the respective 
item. Once confirmed, select the next Check button. 
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8. If the requirement is installed, the Microsoft Visual C++ 2012 Redistributable (x64) window will open with 
options for modifying the Setup. Click Close to continue with the next one.

9. If the requirement is not installed, the Microsoft Software License Terms window appears.

10. Check the "I agree to the license terms and conditions" box, then click Install to continue.
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11. Repeat steps 7-10 as needed for each Check button.

12. Once the installation is complete, an installation confirmation window opens. Click Close to continue.

13. Once all the items are checked or installed, click Next to continue.
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14. Under Configuration, enter a password for MySQL. Then, click the Browse button next to the Directory 
boxes and choose a shared media directory.

 NOTE: C:\ is recommended.

15. Click Next.

16. Under Installation, click Start to initiate the installation.
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17. The installation starts, as shown in the image below.

18. Once the installation completes, the License window opens.
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19. Ensure that your Ross Video representative has provided the required license file.

20. Copy and paste the license into the following directory path:

C:\xchangelicenses

21. In the Installer window, click Copy and then click Next.
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22. Once the installation confirmation is shown, click Finish.

23. When the installation is complete, the Xchange Control Panel opens.
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24. On the Xchange Control Panel, click Start to activate the Database, Web Server, and Workflow one by one, 
as shown in the figures below:

25. Once the installation is complete, from your desktop, open a preferred browser.

 NOTE: Google Chrome version 133.0 is the recommended browser for Streamline Xchange.

26. Alternatively, instead of opening the Xchange Control Panel, go to the following directory:

C:/primestream/scripts

From the Scripts folder, open 1_start-apache and 2_start-mysql.
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 NOTE: The command prompt windows will close automatically when the processes are complete. Do not 
manually close the windows before the processes have been completed.

27. In the browser, type the IP previously selected for Streamline Xchange on the address bar.

28. Enter your credentials and click Sign In.

29. Streamline Xchange is now installed and ready for use.
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Installing Streamline Xchange with 
a Render Node
This chapter describes how to connect a node to the Streamline Xchange database server to offload rendering from 
the database server. The steps include installation of Streamline Xchange, which is covered in “Installing 
Streamline Xchange”.

This chapter discusses the following topics:

• Installing Streamline Xchange with a Node

• Troubleshooting
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Installing Streamline Xchange with a Node

To install Streamline Xchange with Node

1. Extract the Streamline Xchange installer. Right-click the Xchange zip folder, and click extract.

2. Click and enter the XchangeInstaller folder, then double-click XchangeInstaller2.0 to launch the application.

3. On the Streamline Xchange Installer page, enter the following login credentials: 
Username: admin
Password: xxxxx

 NOTE: Please reach out to Ross Video Technical Support for information regarding the password, if it has not 
already been provided.

4. Click Submit.
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5. Under Installation Type, select Install, then check Node. Enter the required database IP in the IP to DB 
Server box and click Next.

 NOTE: Check if the requirements are available to continue. Depending on availability, the installer will give the 
option to continue or install.

6. Click the Check buttons in the order shown in the image below.
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7. After clicking one of the Check buttons, a message will appear to confirm the availability of the respective 
item, as shown in the image below. Once confirmed, continue with the next Check button. 
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8. If the requirement is installed, the Microsoft Visual C++ 2012 Redistributable (x64) window will open with 
options for modifying the Setup. Click Close to continue with the next one.

9. If the requirement is not installed, the Microsoft Software License Terms window appears.

10. Check the "I agree to the license terms and conditions" box, then click Install to continue.
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11. Repeat steps 7-10 as needed for each Check button.

12. Once the installation is complete, an installation confirmation window opens. Click Close to continue.

13. Once all the items are checked or installed, click Next to continue.
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14. Under Configuration, enter the IP address to match where the database is installed. Enter a password for 
MySQL and ensure it is the same as the Xchange database. Then, click the Browse button next to the Directory 
boxes and ensure it is the same shared media directory as the database.

15. Click Next.

16. Under installation, click Start to initiate the installation.
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17. The installation starts, as shown in the image below.

18. Once the installation completes, the License window opens.
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19. Ensure that your Ross Video representative has provided the required license file.

20. Copy and paste the license into the following directory path:

C:\xchangelicenses

21. In the Installer window, click Copy and then click Next.
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22. Once the installation confirmation is shown, click Finish.

23. When the installation is complete, the Xchange Node Panel opens. The Xchange Control Panel is also 
installed, and may need to be opened manually.
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24. On the Xchange Node Panel, click Start to activate the Web Server, as shown in the figure below. Open the 
Xchange Control Panel and click Start to activate the Database, Web Server, and Workflow one by one. The 
notification bar will show green once activated in both the Node Panel and Control Panel.

To log in to phpMyAdmin

phpMyAdmin is a tool that is installed alongside Streamline Xchange.

1. Ensure that the port is open.

2. In a web browser, enter the following path into the search bar:
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localhost/ps_phpmyadmin/

3. When prompted to log in, enter the following credentials:

Username: root

Password: xxxxx

 NOTE: Please reach out to Ross Video Technical Support for information regarding the password, if it has not 
already been provided.

To allow the Node server to access Xchange database

1. On phpMyAdmin, click Xchange on the left navigation pane. Then on the menu bar, click Privileges. Click 
Add user account, as shown in the image below.

2. On the User accounts page, enter the following login credentials:
Username: xchangeadmin
Host name: (Enter the IP to the Node server (192.168.100.28))
Password: xxxxx (Enter a secure, unique password of your choosing.) 
Re-type: Re-type the password.

 TIP: Click the Generate password button to generate a random password.

3. Under Global privileges, select Check all to grant the user all permissions, then click Go.
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4. Under User accounts overview, confirm if the user is connected to the correct IP and has all relevant 
permissions.

5. Go to the following directory:

C:/primestream/server/htdocs/xchange/XChange/data

6. Open config.data.php.

7. Edit the 'xchange_DBHOST' IP to point to the database server.

Edit ‘xchange_DBUSER’ and ‘xchange_DBPASS’ and ensure they are the same username and password as 
what was set in Step 2 of this procedure.
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8. Grant access to the same storage mount on the Node as the database server. Ensure that the Xchange Node 
Panel is running.

9. Open Task Manager to check if apache is running in the background.

10. Enter the following URL in a web browser: 

http://127.0.0.1/xchange/xchange/configsetter
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11. Open the configsetter and rename the storage paths. Wherever it is "xchangemedia", ensure that the storage 
directory matches the connected xchange database. Both the drive letter and VolumeName should match.

12. Once renamed, click the Save button at the bottom of the page.

13. A confirmation window opens.

14. Navigate to the following directory:

C:/primestream/server/conf

15. Open the httpd-existing.conf file in a text editor.

16. Update the path to the shared storage.
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 NOTE: If a media path was set during the installation process, steps 15-16 can be skipped.

17. Set the Media Processor on the DB server to point to the Node API.

• For a Load balanced system:
Go to c:/primestream/server/conf/httpd.conf
Edit the load balance members at the bottom of the file and then save the file.

18. For Rendercluster (at line 665):

19. For Roundcluster (at line 637):

20. At this point, restart the Xchange database and the Node Panel again to apply the new config changes. Send a 
new file and confirm the Node server is rendering by checking the CPU usage or visiting the Node server's 
activity log.
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Troubleshooting

If start apache disappears and stops running, perform the following procedure:

1. Make sure all Vcred C++ 2010-2015 are installed.

2. Open a command prompt and enter the following:

 cd C:/primestream/server/bin

3. Run "httpd.exe".

 NOTE: If you get an error regarding port 80, run the following in the command prompt:

netstat -ano | FINDSTR "80"

If port 80 is listening on PID 4 "NT Kernal system", open the server manager.Under services, look for "World 
Wide Web Publisher" and stop the task.

 NOTE: If the issue has not been resolved, try changing the startup mode and disable it there as well. That should 
clear PID 4 listening on port 80 to run apache.
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Attaching Streamline Xchange to 
Workflow Server
This chapter discusses the following topics:

• Accessing the Streamline Xchange Database

• Setting up Containers

• Adding new Workflow Server containers

• Setting up Volume Name for Mac Clients

• Registering Media from Workflow Server to Streamline Xchange via Scripting
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Accessing the Streamline Xchange Database

To access the Streamline Xchange database

1. Launch the Google Chrome browser.

2. On the browser’s address bar, enter the following URL:

 127.0.0.1/ps_phpmyadmin/

Press the Enter key.

3. On the login page, enter the following login credentials:

Username: root

Password: xxxxx

 NOTE: Please reach out to Ross Video Technical Support for information regarding the password, if it has not 
already been provided.

4. On the Streamline Xchange database, under the Structure tab on the left-hand side, select sgj_pds_servers.

5. Click Insert.

6. On the Insert page, enter the Workflow Server information to add to the Streamline Xchange database to 
connect them.

7. Click Go to save the added Workflow Server information.
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8. Open Streamline Xchange and enter the root admin login credentials.

9. From the menu bar, click Configs.

10. Once the Configs module section is displayed, from the list of submodules on the left, click Groups.

The Groups section is displayed.

11. Select xchangeadmin and then click Destinations. Under MAM Servers, select wfs01.
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This is the newly added Workflow Server. Selecting it grants access to the connected Workflow server. Users 
can upload their work in Streamline Xchange, which is automatically registered in the Workflow server.

Setting up Containers

To register a file on Workflow Server via Streamline Xchange successfully, the user must set up a proper container. 
This is done in the Config Setter.

1. Log into the Streamline Xchange suite with the root admin user.

 NOTE: The Admin module can only be used through root access, not general access.

2. From the menu bar, click Admin.

3. On the Admin module, click Configs.

4. Under Configs, click Config Setter. On the search bar, enter FORK_CONTAINERS.

5. Copy the text from the box into a JSON formatter. Ensure that the directory paths for Windows are correct with 
the drive letter mount point (shown as X in the image below) of the new container for Streamline Xchange to 
Workflow Server.

6. Copy the modified JSON text back into the FORK_CONTAINERS box, replacing the original snippet. Click 
Save Configs.
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Creating a Streamline Xchange Server connection in Workflow Server

1. Open the Workflow Server and log in.

 NOTE: If you require assistance with installing or logging in to Workflow Server, please contact Ross Video 
Technical Support.

2. On the top menu bar, navigate to Modules > Configuration.

3. In the Configuration window, select the Servers tab.

4. Select the + button to create a New Server.

5. Name the server Xchange_##, where ## is a number based on how many servers have already been created.

6. Select the New Server once it is added to the list. In the Server Type drop-down box, select Xchange.

7. Enter the following information in the boxes that are displayed:

› Xchange Api Url: [The verified Xchange API URL.]

› Workflow Server Name: wfs_105
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› Timezone Offset: +5

› API Key: ApiKey

› Auth Secret: ‘secret’

8. Ensure the Any Flavor box is checked, and Anything is selected in the drop-down underneath.

9. Click Store to save the changes.

10. In the Configuration window, select the Properties tab.

11. Add the metadata fields that will be synchronized between the Workflow Server and the Streamline Xchange 
Server through the API calls of the Xchange server.

12. The chosen Properties must match the Xchange Properties.

 NOTE: The Properties are case-sensitive.

13. Click Store to save the changes.

14. In the top menu bar, navigate to Modules > Content Navigator.

15. In the Navigator tab, in the Bins list, right-click General Bins and select Add Bin.

16. Configure the new bin’s properties:



Streamline Xchange Installation Guide (v10.3.0) Attaching Streamline Xchange to Workflow Server • 4–7

› Name: [Enter a name.]

› Type: [Either Normal Bin or Smart Bin.]

17. Select the + button to apply filters to what goes in the Bin:

› Property is the main filter for the bin.

› Operator specifies the main filter.

› Value is the parameters of the main filter.

› Match corresponds to the value.

18. Right-click the created Bin and select Properties. In the window that opens, check the Initially Expanded 
box.

19. In the Bins window, right-click User Bins and select Properties.

20. For the Name, enter Admin. Select the arrow buttons to choose an icon for the bin.

21. Select OK to save the changes.

22. Create a sub-bin under the Admin bin. Ensure the sub-bin is named Xchange Placeholders.

 NOTE: For more information and for assistance with setting up bins, contact Ross Video Technical Support.

Adding new Workflow Server containers

1. On the top menu bar, navigate to Modules > Configuration.

2. On the Configuration menu bar, click General.

3. On the General page, under Containers, click Add File Container to open the Browse For Folder window.

4. Select the file container folder location to allow the Workflow Server to have access to these files. It adds 
Workflow Server Containers, and the Task Agent syncs the URL path from the database.
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5. On the Workflow Server menu, select Modules, then select Content Navigator. The Content Navigator 
window opens.

6. On the Content Navigator window, click Containers to check the list of saved containers accessible to the 
Workflow Server.

Setting up Volume Name for Mac Clients

Having the Volume Name set up allows Mac Clients to have access to the Streamline Xchange database and 
Workflow Server, and import media.

Streamline Xchange Suite

1. Log into Streamline Xchange with the root admin account.

2. From the menu bar, click Admin.

3. On the Admin Module, click Configs.

4. Under Configs, click Config Setter. Then on the search bar, enter "Unix" and/or "VolumeName" and enter the 
unix path.
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Workflow Server

1. On the Workflow Server menu, select Modules, then select Content Navigator.

2. On the Content Navigator window, click Containers to check the list of saved containers accessible to the 
Workflow Server.

3. Double-click on a container to view container settings. Inside container settings, click Select to open up the 
config path.

4. On the Select Path page, under Volume, enter the VolumeName and click OK to save it.
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Adding the Workflow Server as an External Client in the Streamline 
Xchange Database

1. Open Streamline Xchange and enter the root admin login credentials.

2. From the menu bar, click Admin.

3. Select Configs > Config Setter. In the Filter Configs search bar, enter RENDER_SETTINGS.

4. Copy the JSON text from the RENDER_SETTINGS box, and paste it into a JSON formatter.

5. In the JSON formatter, navigate to the VIDEO_RENDER section of the JSON snippet and add the following:

"attachFork": "1",

6. Copy the modified JSON snippet back into the RENDER_SETTINGS box, replacing the original snippet, and 
click Save Configs.

7. In the Filter Configs search bar, enter FORK_CONTAINERS.

8. Copy the JSON text from the FORK_CONTAINERS box, and paste it into a JSON formatter.

9. Ensure that the number at the top of the snippet matches the number of the Workflow Server. In the screenshot 
below, it is “1”.

10. Modify the directory on the “forkmedia” line under the “default” section to match the media directory for 
Workflow Server and Streamline Xchange, including the xchangemedia folder.
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11. In the “default” section, add the following:

"containerName": "dropped"

12. Copy the modified JSON snippet and paste it into the FORK_CONTAINERS box, replacing the original 
snippet, and click Save Configs.

13. Open phpMyAdmin and log in using the root administrator account.

14. Navigate to xchange > sgj_pds_servers. Select Insert.

15. Enter the following information in each corresponding Value box:

› id: 1

› name: wfs_105

› xmli_ip: [Enter the IP of the machine.]

› xmli_port: 8053

› in_use: 1

 NOTE: Ensure that the Null boxes are not checked for the values that are entered.

16. Click the Go button.

The Workflow Server is now registered under sgj_pds_servers.
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17. Navigate back to Database: xchange, and select external_clients. Select Insert.

18. Enter the following information in each corresponding Value box:

› id: 1

› name: wfs_105

› access_key: apiKey

› secret: secret

 NOTE: Ensure that the Null boxes are not checked for the values that are entered.

19. Click the Go button.

20. Navigate back to Browse, then click Insert. Enter the following information in each corresponding Value box:

› id: 2

› name: workflow-server

› access_key: fb4e7623aa

21. Click the Go button. Navigate back to the Browse tab to confirm the information is correct.

22. Log out of phpMyAdmin.

The Workflow Server and Streamline Xchange can now communicate.

 NOTE: Contact Ross Video Technical Support if you encounter any issues related to connecting the Workflow 
Server and Streamline Xchange.
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Registering Media from Workflow Server to Streamline Xchange via 
Scripting

After attaching Streamline Xchange to Workflow server, you can register media from Workflow Server to 
Streamline Xchange. To do this, import the attached JSON format code below into your Workflow Server scripting 
tab.

After importing the scripts, go to Workflow Server Script Command Setup: HTTP Post and edit the API URL to 
include the necessary file path. Copy and paste the attached API payload below under Request.

{ 
 "name": "XCH01 - Publish Clips to Xchange", 
 "description": "Script to send asset to Xchange", 
 "triggers":  
  [ 
   { 
    "eventID": "00000000", 
    "event": "Drop", 
    "objectType": "Bin", 
    "objectTypeID": "7062696E", 
    "objectName": "videoWatchFolder", 
    "disabled": false 
   }, 
   { 
    "eventID": "00000000", 
    "event": "Drop", 
    "objectType": "Bin", 
    "objectTypeID": "7062696E", 
    "objectName": "AMEProfile", 
    "disabled": false 
   }, 
   { 
    "eventID": "00000007", 
    "event": "Ingest Stop", 
    "objectType": "Destination", 
    "objectTypeID": "64657374", 
    "objectName": "Shared Storage", 
    "disabled": false 
   }, 
   { 
    "eventID": "00000000", 
    "event": "Drop", 
    "objectType": "Destination", 
    "objectTypeID": "64657374", 
    "objectName": "Register Clip(s) to Xchange", 
    "disabled": false 
   } 
  ], 
 "commands":  
  [ 
   { 
    "recID": "D1D4859E", 
    "parent": "00000000", 
    "order": 1, 
    "commandID": "0000002D", 
    "command": "Control Progress Window", 
    "settings":  
     { 
      "skipCommand": false, 
      "onFailure": 1, 
      "summary": "Never show progress window, 
not for messages", 
      "timeoutSeconds": 0, 
      "forever": true, 
      "notForMessages": true 
     } 
   }, 
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payload={ 
    "applicationName": "FORK", 
    "requestType": "registerMedia", 
    "objectType": "media", 
    "recordId": "%scriptVar,'clipid'%", 
    "parentRecordId": "null", 
    "pdsId": "1", 
    "pdsName": "wfs01", 
    "project_bin_id": "%scriptVar,'binid'%", 
    "creator": "administrator", 
    "name": "%scriptVar,'NameNew'%", 
    "forkFilePath": "%scriptVar,'forkFilePath'%", 
    "forkFilePathIsUnix": "0", 
    "forkVolume": "/Volumes/MEDIA", 
    "forkDriveLetter": "M", 
    "renderWithForkFile": true, 
    "timecodeIn": "00: 00: 00: 00", 
    "createdTime": "%scriptItemVar,'Date'%", 
    "createdTimeOffset": "+4", 
    "metadata": { 
        "tcstart": "%scriptVar,'startTime'%", 
        "Category": "%scriptItemVar,'Category'%", 
        "AMEupload": "%scriptItemVar,'AMEupload'%" 
    } 
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Adding a New Render Profile with 
the Workflow Server Container
This chapter discusses the following topic:

• Adding a new Render Profile
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Adding a new Render Profile

To add a new render profile

1. Log in to Streamline Xchange via the root admin account. From the menu bar, click Admin.

2. On the Admin module, click Configs.

3. Under Configs, click Config Setter. Then on the search bar, enter FORK_CONTAINERS.

4. Copy the text from the box into a JSON formatter.

5. Add a new profile in the FORK_CONTAINERS variable, as shown in the image below.

6. Copy the modified JSON text back into the FORK_CONTAINERS box, replacing the original snippet. Click 
Save Configs.

7. On the search bar in the Config Setter, enter RENDER_SETTINGS. Copy the text from the box into a JSON 
formatter.

8. Add a new profile in the VIDEO_RENDER section of the RENDER_SETTINGS variable.
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9. Add a new profile in the ORIGINAL_PATHS section of the RENDER_SETTINGS variable.

10. Copy the modified JSON text back into the RENDER_SETTINGS box, replacing the original snippet. Click 
Save Configs.

11. Restart the Workflow kit or renderkit job.

12. Click the Configs module, then click Groups. Under the Groups list, click a group, then click Render 
Profiles.

13. Enable the required render profile for the group.
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Setting up Xchange Proxies for 
Playback in the Workflow Suite
This chapter describes how to set up Xchange proxies for playback in Workflow Suite.

This chapter discusses the following topic:

• Setting up Xchange Proxies
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Setting up Xchange Proxies

To set up Xchange proxies for playback

1. Login to Streamline Xchange via the root admin account. From the menu bar, click Admin.

2. On the Admin module, click Configs.

3. Under Configs, click Config Setter. Then on the search bar, enter FORK_CONTAINERS.

4. Copy the text from the FORK_CONTAINERS box into a JSON formatter.

5. Add the following information. Each fork entry should get a "containerName" property.

6. Copy the modified JSON text back into the FORK_CONTAINERS box, replacing the original snippet. Click 
Save Configs.

7. On the search bar, enter RENDER_SETTINGS.

8. Copy the text from the box into a JSON formatter. Add the following information. For each render setting 
proxy that should attach to fork, add "attachFork" at the end of each render profile setting.

9. Copy the modified JSON text back into the RENDER__SETTINGS box, replacing the original snippet. Click 
Save Configs.
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Configuration of Users
This chapter discusses the following topics:

• Accessing the Configs Module

• Configs module user page

• Adding a User

• Viewing the User List

• Editing a User

• Deleting a User
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Accessing the Configs Module

In Streamline Xchange, it is possible to create user profiles through an admin account, including the root admin 
account.

To access the Configs module

1. From the menu bar, click Configs.

The Configs module section opens, displaying the following information.

The Configs module allows an Admin to create user profiles, edit existing user details, and delete user profiles. 
The Configs module also enables an Admin to grant specific rights to users, create separate groups as per tasks, 
and add user profiles to the respective groups.

Configs module user page
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1. Configs submodules: This is a list of tools that allows the Admin to create, edit, or delete functionalities in 
Streamline Xchange.

2. List of users in Xchange suite: This is the list of all the users using Streamline Xchange.

3. Add/Remove User: This tool allows an Admin to add a new user or remove an existing user.

4. User Details: This section displays user details that are editable.

5. User Groups: This section displays the user group a particular user belongs to. To add a user to the user group, 
refer to the “Configuration of Groups” chapter of this Guide. Click on a user name to check its assigned user 
group.

6. Licensing tab: This displays the number of web users and users logged in through the Adobe panel.

Adding a User

To add a user

1. On the Configs module section, under the user list, click '+' to open the Create New User page.

2. The Create New User page opens.

3. Fill in the new user information:

• First Name: Enter the first name of the user.

• Last Name: Enter the last name of the user.
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• Username: Enter the required username.

• Workflow Server User: Enter the Workflow Server ID, if the user has the necessary setup to identify 
credentials coming from the local directory and be in-sync with each other.

• Email: Enter the user’s email address if the user wants to receive email notifications.

• User Type: From the User Type dropdown, select the appropriate user type. The Admin, Manager, and User 
profiles have different access rights and privileges.

• Default Password: Enter the user’s password.

4. After entering the new user’s information, click Create.

 NOTE: The Admin can either enter Workflow Server User information or go ahead with regular manual entry to 
create a login ID. Workflow Server Use and Email fields are optional.

The new user can now be seen in the user list.



Streamline Xchange Installation Guide (v10.3.0) Configuration of Users • 7–5

Viewing the User List

1. Search users by name.

2. Check Logged In Users to pull up currently online users.

3. User list by name.

4. List of usernames.

5. Check the last login time of users.

6. Check which users are logged in.

7. The users’ IP address locations.

Editing a User

1. Click on a user to open the User Details.

2. In User Details, edit the information as required:

• Workflow Server User: Enter the user’s Workflow Server User ID.

• First Name: Enter the first name of the user.

• Last Name: Enter the last name of the user.

• Username: Enter the required username for the user.

• Email: Enter the user’s email address.

• User Type: Select the user type from the dropdown.

• Change/Confirm Password: Change and confirm the user’s new password.
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3. Click Save.

Deleting a User

1. Click on a user to select them. Once selected, on the Configs module section under the user list, click '-'.

2. When the prompt box opens, click Yes to delete the user.
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Configuration of Groups
After creating a user profile, an Admin can add the user to groups. A group consists of a set of users with specific 
tasks and privileges. Every Streamline Xchange suite group is granted access rights by the Admin depending on 
their task requirements. The users can only have access to the permissions assigned to their respective groups. It is 
possible to create new groups, add user profiles, and delete groups through the root admin access or regular admin 
access. Admins can perform group configuration by going into the Configs module of the Streamline Xchange 
suite.

This chapter discusses the following topics:

• Accessing Groups

• Configs Module Group Page

• Adding a Group

• Editing a Group

• Deleting a Group

• Group Functionalities
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Accessing Groups

To access groups

1. From the menu bar, click Configs.

2. Once the Configs module section is displayed, from the list of submodules on the left, click Groups. The 
Groups section is displayed.

3.  The functions a Streamline Xchange Admin can perform in the Groups section are as follows:

• Create a group 

• Edit group information

• Add or remove a user from a group 

• Grant specific permissions to a group

4. Users can check their respective groups by going to the Users section and clicking on a username.Users can 
also go to the Groups section and click on a group to check the list of users.

Configs Module Group Page
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1. Configs submodules list: This is a list of tools that allows the Admin to create, edit, or delete functionalities in 
the Streamline Xchange suite.

2. List of groups in Xchange suite: This is the list of all the Streamline Xchange suite groups. Users can search 
for groups by entering the group name in the Search Groups box.

3. Add/Edit/Delete Group: This tool allows a new group to be added, a group to be edited, or for an existing 
group to be removed.

4. Group functionalities: This section displays the list of functionalities where an Admin can grant permissions 
or access rights to groups based on their tasks.

5. List of permissions: This section displays permissions that an admin can assign to a group.

Adding a Group

1. Under the Groups list, on the Configs module section, click '+'.

2. The Create New Group window opens.



8–4 • Configuration of Groups Streamline Xchange Installation Guide (v10.3.0)

3. Fill in the new group information:

• Group Name: Enter the group name.

• Group Description: Enter the group description.

4. After entering the new group information, click Create.

5. Once created, the new group appears under the Groups list.
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Editing a Group

1. Under the Groups list, select a group. Then click on the settings icon to open the Group Info page.

2. In Group Info, edit the group’s information as required.

• Group Name: Enter the group name.

• Group Description: Enter the group description.

3. Click Edit to save the changes.
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Deleting a Group

1. Click on a group to select it. Once selected, on the Configs module section, under the Groups list, click  '-'.

2. When the the prompt box opens, click Ok to delete the group.

Group Functionalities

The Streamline Xchange group section comes with a list of groups and related functionalities containing access 
rights/permissions/privileges. Admins can grant these access rights to groups depending on its user member's roles 
and responsibilities. Since the user can be part of one group or multiple groups, they will automatically gain any 
permissions the group has access to.

1. On the Groups list, click on a group. The list of functionalities appears.

Every functionality comes with specific permissions and privileges granted by the Admin. Once assigned, the 
group’s members can only access the list of rights given to their respective groups by the Admin. The user cannot 
carry out a task if it is not covered under the user's group's privileges. The Admin can grant or remove any 
permission from a group at any time.

General

The General functionality covers all the tools for a user to work on in the Xplore module of Streamline Xchange.

• To grant access, under the Groups list, click a group, then click General. This opens the General page.

• On the General page, select the tools needed to assign to the group.
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Now the group has permission to use the selected tools in the Streamline Xchange suite. The Admin can also clear 
boxes to remove any permission, making the group unable to use the tool.

Users

The Users functionality allows the following functions:

• See a list of user members: Under the Groups list, click to select a group, then click Users. It shows the full list 
of users along with user members of the selected group. A name can be entered in Search Users to find them by 
name.

• See only group members: To see only group members, select In Group Only.

• Add or remove members to a group: To add a new member to a group, select a member name. To remove a 
member, clear the checkbox selection of the member. You can always visit the Users section to check if the 
member is added or removed from a group.

Modules

The Modules functionality allows an Admin to grant a user permission to use specific modules. To grant 
permission, click to select a group and then click Modules. On the Modules page, select the checkboxes of 
modules to grant access to the group.
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Forms

The Forms functionality allows an Admin to grant access to various metadata forms created in the Metadata 
section of the Configs module. Forms add specific details to different media assets and projects. When granted 
access, the group members can only view and select from the permitted forms and edit form details.

Media forms: Media forms display all the individual media asset details.

• To grant access, under the Groups list, click a group, then click Forms. It opens the Forms page.

• Click Media, and then select the Form Name(s) to grant access to the group.

Media Info displays the metadata details of a media asset. The Admin can grant access to all media forms but can 
only select one Media Info as default at a time. Choosing a Media Info Default form only allows the user to view 
the details related to the default form. The Admin can grant access to only one Registration Default at a time. It 
automatically puts all media assets in a particular project under the default registration form.

Project forms: Project forms display all the project related details.

• To grant access, under the Groups list, click a group, then click Forms. This opens the Forms page.

• Click Project, and then select the Form Name(s) to grant access to the group.

Different project forms allow access to a different set of tools for users to edit project details. Selecting a Default 
against a Form Name provides access to only the default project form tools.

Smart Bins

The Smart Bins functionality allows an Admin to grant access to various pre-determined or custom-made smart 
bins in the Streamline Xchange suite. Smart bins are created in the Smartbins section of the Configs module. 
Smart bins classify media assets according to their metadata. It allows easy filtering of all media assets on the 
Streamline Xchange suite. On the Smart Bins page, select the Smartbin checkboxes to grant access to the group.
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Destinations

The Destinations functionality allows an Admin to grant access to other MAM Servers as well as Social Servers to 
a group. The groups with access to another MAM server can upload their work in Streamline Xchange, which then 
gets updated in the connected server automatically. There is also an option for an internal server if the group wants 
to keep their task only within the Streamline Xchange server. The Admin can grant access to all servers but can only 
keep one as the default server.

Social Servers contain a list of social networking platforms. The users with access to the social media platforms 
can upload their work on Streamline Xchange, which gets updated in the respective social media servers.

Workflow Server Actions

The Workflow Server Actions functionality contains all the automation of actions configured within the workflow 
server. Actions are created in the Actions section of the Configs module. The Admin can select a specific or all 
Action which grants permission to access.
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Render Profiles

The Render Profiles functionality allows an Admin to grant rights to different render profiles in the Streamline 
Xchange suite. Render profiles are created in Render_Settings under the Configs Setter. Render profile settings 
create videos of multiple resolutions with different proxies. Streamline Xchange can have multiple render profiles. 
The Admin can provide access to single or numerous render profiles but can only select one as the default setting. 
The Admin can also grant permission to re-render the feature. The user can choose a render profile while uploading 
video and selecting the permitted render resolutions while performing different videos on videos.

• To grant access to render profiles, click to select a group, then click Render Profiles. Then select access to 
provide access to the specific render profile.

• Select Default to grant default render profile rights to the selected group.

• Select Re-Render to grant access to the re-rendering feature to the selected group. 

• The Admin can grant render resolution access to groups for performing tasks. It enables groups to select their 
choice of video resolution while streaming, downloading, publishing videos, or sending videos to ReviewHub.

 NOTE: The Admin can only set a render profile to Default after selecting access.
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Projects

The Projects functionality allows for the following:

• Destination Servers: Admins provide access to various Streamline Xchange servers, allowing groups to transfer 
projects from one Streamline Xchange database to another. 

• Archive Workflows: Archive permissions allow groups to put different workflow assets into the archive folder.

Workspaces

The Workspaces functionality allows an Admin to grant rights to personalized workspaces created in the 
Workspace module of Streamline Xchange. Admins can grant access to these workspaces and set a default 
workspace for a group.
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AI Languages

The AI Languages functionality allows for granting rights to languages used for AI transcription. The Admin can 
set a default language for automatic transcription of clips. The Auto detect language option automatically detects 
the language used in a video clip.
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Installing the Streamline Xchange 
Adobe Panel - Windows
This chapter discusses the following topic:

• Installing the Streamline Xchange Adobe Panel in Windows
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Installing the Streamline Xchange Adobe Panel in Windows

To install the Streamline Xchange Adobe Panel for Windows

1. To extract the Streamline Xchange Panel folder, right-click the provided XchangePanel zip folder and click 
Extract All. Select a preferred location for the folder and click Extract.

2. Go to the following directory to find the Adobe extensions folder:

C:\Program Files(x86)\Common Files\Adobe\CEP\extensions

Drag the XchangePanel folder and drop it inside the Adobe extensions folder.

3. Launch the Adobe application. On the menu bar, under Window, select Extensions, and then click 
Primestream Xchange.
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4. On the Streamline Xchange launch window, click the settings/gear icon on the screen's top right corner.

5. On Configurations, beside the Profiles drop-down list, click '+'.
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6. Fill in the new configuration information and select options based on requirements:

• Profile label: Enter a new profile name, that is 'Xchange 54' (last octet of the IP to Xchange).

• Media Access Method: Select the media access method as per requirement:

› Select Shared Storage if the storage is connected to the edit machine, and you wish to work with the files 
directly on the storage.

› Select Transfer Media if the storage is not connected to the edit machine and/or you wish to download 
the media on the local machine.

• Auto Login: Select Yes to enable Auto Login or select No to disable it.

• Keep Temp Files: Select Yes to enable Keep Temp Files or select No.

 NOTE: xmls created on import are saved in the Media/**Date**/ folder.

• Allow All Register: Select Yes to enable Allow All Register. It shows all Premiere Project assets as 
available to be registered when selecting Register Media to Xchange. Select No to disable Allow All 
Register. This only shows the Premiere Project assets that are not registered to Xchange as available to be 
registered when selecting Register Media to Xchange.

• Video Preview: Select Yes to enable Video Preview. It allows you to scrub in the thumbnail of a clip and 
scrub the video quickly. Select No to disable Video Preview.

• Keep prproj name: Select Yes enable Keep prproj name. When importing a Premiere Project into Premiere, 
it downloads the prproj to the local machine. It renames it to the name of the asset in Xchange so that when 
imported into Premiere, the project name matches the asset name in Xchange. Select No to disable. 

• New World Script: Select Yes to enable New World Script (new API code in Premiere) or select No. 

• Max Transfers: From the drop-down, set the maximum concurrent transfers as per requirement. It is best to 
start with 1 and then go ahead from there. 

• Server IP: Set the Server IP address of the Xchange Database (Head).
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• Chunk Size (MB): From the drop-down, select the required Chunk size. Chunk sizes come in MB. It is the 
chunk size for writing/copying files to the storage. Select 5MB unless otherwise desired. 

• Config file: On Config file setting, click Show in finder that opens a Finder window to show the config file 
location so that you can copy and paste it to other machines.

• Xchange Import Directory: Enter the XchangeTemp Directory to point to the /xchangetemp/ directory 
in your storage.

• Click to Create Working Directories: Click Click to Create Working Directories and select the local 
User Documents folder. The Streamline Xchange Panel will create a new folder called XchangePanel and 
create all of the working directories in that folder.

› Presets Directory - To point the XchangePanel at a directory on the shared storage to access the Adobe 
Export Presets, modify the Presets Directory config to point at the shared storage location.

• Click Save.
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• Close Streamline Xchange Extension in Premiere.

• Put export presets (.epr) in the Documents/XchangePanel/Presets folder.

• Open the Streamline Xchange Extension.

• Enter Xchange User login credentials to log in.

 NOTE: The configuration is stored in configs.json in the following location: /Users/*Username*/Library/ 
Application Support/Primestream/configs.json
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Installing the Streamline Xchange 
Adobe Panel - MacOS
This chapter discusses the following topic:

• Installing the Streamline Xchange Adobe Panel in MacOS
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Installing the Streamline Xchange Adobe Panel in MacOS

To install the Streamline Xchange Adobe Panel for MacOS

1. To extract the XchangePanel folder, double-click to unzip the file. The Streamline Xchange panel folder is 
extracted onto the desktop.

2. Go to the following directory to find the Adobe extensions folder:

Library\Application Support\Adobe\CEP\extensions

Drag the XchangePanel folder and drop it inside the Adobe extensions folder.

3. Launch the Adobe application. On the menu bar, under Window, select Extensions, and then click 
Primestream Xchange.
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4. On the Streamline Xchange launch window, click the settings/gear icon on the screen's top right corner.

5. On Configurations, beside the Profiles drop-down list, click '+'.



10–4 • Installing the Streamline Xchange Adobe Panel - MacOS Streamline Xchange Installation Guide (v10.3.0)

6. Fill in new configuration information and select options based on requirements:

• Profile label: Enter a new profile name, that is 'Xchange 54' (last octet of the IP to Xchange).

• Media Access Method: Select the media access method as per requirement:

› Select Shared Storage if the storage is connected to the edit machine, and you wish to work with the files 
directly on the storage.

› Select Transfer Media if the storage is not connected to the edit machine and/or you wish to download 
the media on the local machine.

• Auto Login: Select Yes to enable Auto Login or select No to disable it.

• Keep Temp Files: Select Yes to enable Keep Temp Files or select No.

 NOTE: xmls created on import are saved in the Media/**Date**/ folder.

• Allow All Register: Select Yes to enable Allow All Register. It shows all Premiere Project assets as 
available to be registered when selecting Register Media to Xchange. Select No to disable Allow All 
Register. This only shows the Premiere Project assets that are not registered to Xchange as available to be 
registered when selecting Register Media to Xchange.

• Video Preview: Select Yes to enable Video Preview. It allows you to scrub in the thumbnail of a clip and 
scrub the video quickly. Select No to disable Video Preview.

• Keep prproj name: Select Yes enable Keep prproj name. When importing a Premiere Project into Premiere, 
it downloads the prproj to the local machine. It renames it to the name of the asset in Xchange so that when 
imported into Premiere, the project name matches the asset name in Xchange. Select No to disable. 

• New World Script: Select Yes to enable New World Script (new API code in Premiere) or select No. 

• Max Transfers: From the drop-down, set the maximum concurrent transfers as per requirement. It is best to 
start with 1 and then go ahead from there. 

• Server IP: Set the Server IP address of the Xchange Database (Head). 

• Chunk Size (MB): From the drop-down, select the required Chunk size. Chunk sizes come in MB. It is the 
chunk size for writing/copying files to the storage. Select 5MB unless otherwise desired. 

• Config file: On Config file setting, click Show in finder that opens a Finder window to show the config file 
location so that you can copy and paste it to other machines.
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• Xchange Import Directory: Enter the XchangeTemp Directory to point to the /xchangetemp/ directory in 
your storage.

• Click to Create Working Directories: Click Click to Create Working Directories and select local User 
Documents folder. The Streamline Xchange Panel will create a new folder called XchangePanel and create 
all of the working directories in that folder.

› Presets Directory - To point the XchangePanel at a directory on the shared storage to access the Adobe 
Export Presets, modify Presets Directory config to point at the shared storage location.

• Click Save.
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• Close Streamline Xchange Extension in Premiere. 

• Put export presets (.epr) in the Documents/XchangePanel/Presets folder. 

• Open the Streamline Xchange Extension. 

• Enter Xchange User login credentials to log in.

 NOTE: The configuration is stored in configs.json in the following location: /Users/*Username*/Library/ 
Application
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Configuring Microsoft AI
This chapter discusses the following topic:

• Setting up Microsoft AI
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Setting up Microsoft AI

A database admin in Streamline Xchange can toggle the Microsoft AI settings.

To setup Microsoft AI

1. Login to Streamline Xchange via the root admin account. From the menu bar, click Configs.

2. On the Groups list, click xchangeadmin, then click Modules. On the Modules page, select Elastic Data 
Viewer

The metadata that is analyzed from Microsoft AI can now be viewed.

3. On the group functionalities list, click General and select to enable the following tools:

4. On the group functionalities list, click AI Languages and select the following languages to enable:
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